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RELEASE NOTES

LOOKOUT 4.5 RELEASE NOTES
Welcome to Lookout 4.5. This edition of the Lookout HMI/SCADA
package introduces the following new features:

• ActiveX control object—include any ActiveX control in your Lookout
processes, including ten versatile controls from National Instruments
ComponentWorks included with Lookout 4.5.

• Aggregate objects—create Lookout processes you can then use and
reuse like objects, without tedious and repetitive rebuilding of systems
and processes you have built before.

• Citadel Control—archive and maintain your Citadel databases from
within a Lookout process.

• HTML reports—generate HTML reports from Lookout that contain
tables and charts, text, your own HTML code, and more.

• DataSocket object—connect to a wide range of National instruments
Hardware and software using National Instruments DataSocket
technology.

• Mailer object—distribute Lookout data or alarms through your e-mail
system.

• Mouse and Joystick objects—use mouse and joystick inputs in your
processes.

• New Driver objects—including drivers for Allen-Bradley Logix, Fatek
MA/MB/MC, Mitsubishi CLM, Modbus Daniel, Modbus Omniflow,
National Instruments DeviceNet, Phoneducer, ScanData, and Siemens
S7-HMI.

• Image Navigator—a new, large library of graphics, from symbols to
detailed drawings.

• Enhancements to usability and functionality, including a new color
selector with 24-bit color capability, multiline text entry and display,
live data display for connections in the Connection Browser, and
Object Explorer enhancements such as object copy and paste, and easy
access to the Edit Database and Edit Connections dialog boxes both
through objects and individual data members.

™
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The Lookout 4.5 Release Notes contain the following information:

• Requirements for running Lookout 4.5

• New features and corrections that did not make it into the print
documentation

• Known issues with Lookout 4.5

• A roadmap to where you can find answers to your questions about
Lookout 4.5

• Information on compatibility issues between Lookout 4.5 and earlier
versions of Lookout

For the most recent Lookout news and updates, point your browser to
this site:

http://www.ni.com/lookout/
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Requirements
Lookout requires the following:

• Pentium class PC or equivalent, running at 90 MHz or faster

• Windows 98/95/Me, Windows NT version 4 or later, or Windows 2000

• At least 32 MB RAM

• You will need between 17 and 112 MB free disk space for Lookout
(depending on your installation options), plus as much 100 MB or
more for data logging (depending on how much data you intend to log
to the Citadel database). You should also have about 50 MB of disk
space for file swapping on Windows NT/2000 computers

• Network card and TCP/IP networking installed on the computers you
want to connect, if you intend to take advantage of Lookout
networking

• Adobe Acrobat Reader version 4 or later, which you can install from
the Lookout\Documentation folder (launch rs40eng.exe) or
from the Adobe web site

While minimum requirements for running Lookout will run Lookout
processes, you may find that large processes which draw heavily on
computer system resources will benefit from faster computers that have
more RAM and disk memory than the minimum requirements. For
example, if your Lookout processes 25,000 traces or more, you should use
a Pentium class 450 MHz computer with at least 256 MB of RAM.

Because Lookout can run 24 hours a day, your computer should have some
form of AC power surge protection. An uninterruptible power supply
(UPS) provides the ultimate protection. A UPS provides complete isolation
between the AC power source and the computer and has backup battery
power if there are blackouts and brownouts. A quality surge protector will
protect your computer from most electrical surges and spikes if you do not
need battery backup.

Caution If you are running Windows 95 with no service pack upgrades, you may
experience difficulties in networking with Lookout 4 or greater. If your computer begins to
behave erratically after networking with Lookout 4 or greater, you may need to install an
updated kernel32.dll from Microsoft. You can download this upgrade from Microsoft
using the following URL:

http://www.our-town.com/win95maint/win95maint.htm
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Installation
Installing Lookout is more than just copying files to your computer.
You must register Lookout for long term use of your I/O points, and for
instances of Lookout that are intended to run server processes, you must
also register to activate your client connections. There are also a number of
Lookout system configuration options you should set when you install.
If you plan on networking with Lookout, you should also test to make sure
TCP/IP is present and running on all the computers you intend to use
Lookout with over a network.

Avoid installing Lookout 4.5 over Lookout 3.8 or earlier. Either uninstall
Lookout 3.8, or put Lookout 4.5 in a new directory. You can transfer or copy
Lookout 3.8 process files for converting. If you were using a pre-release
version of Lookout 4.5, either a beta or the Lookout 4.5 Preview, you
should uninstall before installing the release version of Lookout 4.5.

Note You can run Lookout 3.8 on the same computer with Lookout 4 and higher, and a
process in one can be networked to a process in the other using NetDDE. Start the earlier
version of Lookout first, though, if you intend to run both versions on one computer.

If you are replacing your current copy of Lookout with Lookout 4.5, and
your previous version was purchased from National Instruments, your
earlier registration keycode will work to maintain your I/O licensing.
You must register your client connection levels separately, however.
Get your client connection keycode (and an upgraded I/O point keycode as
well, if necessary) by registering Lookout with National Instruments, using
the Lookout Registration Form included in your Lookout package.

See Chapter 1, Installing Lookout, in the Getting Started with Lookout
manual for detailed information on installation, testing TCP/IP networking,
and configuring the Lookout system options.

Registration
You must register your copy of Lookout to have full functionality of the
software and access to all your I/O points and client connections. Your I/O
points and client connections are activated by a Lookout keycode you get
when you register the software. See Chapter 1, Installing Lookout, of the
Getting Started With Lookout manual for more detailed information on
registering Lookout and getting your keycode.

You can register by phone or fax using the using the registration form
provided with your software, or you can register and get your keycode over
the Internet by pointing your browser to:

http://www.ni.com/keycode
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If you have not already created your personal profile on NI web, you will
have to do so before you can register Lookout and get a keycode across
the web.

Corrections and Additions to the Documentation
This section contains information and corrections which did not make it
into the Lookout manual set.

CitadelControl
You can use the CitadelControl object to archive and restore your Citadel
databases. The CitadelControl object archives data from any Citadel
database (the source database) to any other Citadel database (the target
database). You can specify what data is archived, and set the time range for
the operation.

You can automate archiving so that it takes place on a regular basis, and you
can use multiple CitadelControl objects to archive data to several backup
computers across the network. You can use CitadelControl to archive data
from several Citadel databases into one archive database, and you can
archive specific data from an archive database out to special purpose
databases or back to active databases to restore data that has been corrupted
or lost.

To create a CitadelControl object, select CitadelControl from the Select
Object Class dialog box (from the Logging category). The following
dialog box appears.
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Note Unlike most Lookout object classes, the CitadelControl has no parameters. All the
yellow expression fields on this dialog box are actually connections to CitadelControl data
members. You can create a CitadelControl object without filling any of the yellow
expression fields, supplying the necessary values through a direct or remote source
connection later in your development efforts. If you do enter an expression in one of these
fields when you create the CitadelControl object and later make a connection to that data
member from an object other than the one you used when creating the CitadelControl, you
will discover that your new connection replaces the original one if you edit the object’s
properties through the dialog box. In the same way, any entries you make when you create
a CitadelControl object will appear when you edit connections to that object.

Use Archive trace matching this pattern (the What data member) to
select the data you want copied. You must supply a Lookout data path (with
the appropriate relativity) for the data you want to archive.

You cannot use path abbreviations for data you want to trace. You must
include the computer name or use the appropriate wildcard. In other words,
"\\paroikos\PSMonitor\Modbus.1" is a valid path for a data trace,
while "\\.\PSMonitor\Modbus.1" is not.

You can use wildcards and pattern matching to select a large number of
traces from a given Citadel database, however. See the Pattern Matching
section for more information on how to define the data you want copied.
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Note As with any other string you use in a Lookout expression, you must use double
quotes to delineate what you enter for the Archive trace matching this pattern (the What
data member). If you connect a TextEntry object to this data member, however, you need
not use double quotes because Lookout inserts them for you when you enter a string
through the TextEntry object. This is a great advantage if you want to change the traces you
archive. On the other hand, if you use the yellow expression field in either the Create
CitadelControl dialog box or in the Edit Connections dialog box, you can browse to find
the data you want to archive.

Set the From and To fields (the FromWhen and ToWhen data members) to
define the time range for the data you want to archive. Setting either field
to 0 extends the range to the limits available: a 0 in the From field means
the CitadelControl will archive data from the beginning of the database.
A 0 in the To field means that the CitadelControl will archive data to the
most recent data available.

You use From the database in this folder (the FromWhere data member)
to select the Citadel database you are archiving data from. The data will be
copied to the database you set in To the database in this folder (the
ToWhere data member). When you set these fields as parameters in the
Create New CitadelControl dialog box, you can browse your directory
structure to select the Citadel directory you want to set as your source or
target database.

When this value transitions to true (the Start data member) can contain
or be connected to a logical value—either a Lookout control or a Lookout
expression that evaluates to true or false. You can archive data regularly
using a Lookout Pulse object to trigger operation of CitadelControl.

Note The CitadelControl only archives new data. It does not copy over data it has already
archived in the target archive. Additionally, if you cancel archiving for some reason, the
data already archived when you activate the Cancel data member stays in the archive. The
CitadelControl will then take up archiving where it left off the next time you start archiving
(assuming you have not changed the other settings).

You can set Delete source data while archiving if this is true
(the DeleteEnabled data member) either as a constant or a variable.
When this parameter is true, Lookout deletes information from the source
database when the CitadelControl copies it to the target database.
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Archiving Data
The primary use for CitadelControl is for archiving and backing up data.

When you archive data with CitadelControl, it copies data from your source
directory to your target directory. Your target and source directories can be
on your local computer or on a computer located somewhere else on your
network (as long as the remote computer is running the Citadel database).

CitadelControl copies data from the source computer to the target
computer. It copies data in pages, units of data 4K in size. (Exactly how
much data is contained in a given 4K page depends on the type of data and
the resolution at which you are logging it.) When CitadelControl copies
data, it copies the entire page, including data you may not have requested.

If you have enabled Delete source data while archiving (the
DeleteEnabled data member), and your start or stop point for archiving
data is in the middle of a database page, the CitadelControl does not delete
the page in order to preserve data that was not covered in the request.

You should archive data to a database that has no Lookout process logging
input. This database, having no setting on how long to hold data, will keep
your data perpetually. This way, when you archive data from a Citadel
database configured to store data for three days to an archive database with
no restrictions on how long data is held, the archived data will not be
removed after the time configured for it in the original database. It is held
with a perpetual lifespan.

If you move data from your archive to a database with restrictions on how
long data is to be held, the data will be inserted initially with a perpetual
lifespan. As soon as Lookout logs new data with that trace name to the
database, however, the lifespan for that data takes effect again and your
restored data will be removed if it is older than the limits set in the database
configuration of the Lookout process logging that data.

Caution This represents a change of behavior in the Citadel database. Formerly, Citadel
was not aggressive in enforcing data age limits, deleting data only at certain times. Citadel
now removes over-age data regularly. If you had been depending on loose enforcement of
data lifespans in your data backup, you should take the more timely enforcement into
consideration.

Additionally, you should be aware that if you log data to your archive database, any
lifespan setting on data in the process you are logging from will be enforced in your archive
database. For this reason we recommend that you never log data directly to an archive
database.
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You can archive data with identical or similar names from different
processes to a single archive without conflict, because the name of the data
includes its source process name.

You are not limited in the number of archive databases you create. You can
create special purpose report databases as well as permanent archives,
depending on your needs.

At this time you can only access data in your archive database in two ways:
by using SQL queries or by creating a dummy process with the same name
as the process in which the archived data originated. Your dummy process
has to have your archive directory set as its default data directory, and
should only have a Lookout HyperTrend object in it (in order to prevent
accidentally logging to the archive and changing your data lifespans).
You can then view the archived data the same way you would through the
original process, using a URL with the process name and trace name for the
HyperTrend. Notice that you cannot run this dummy process at the same
time as the actual data source process, because of the conflict of process
names.

You could also restore data to the database in the original process and view
it through the original process (as long as the source database is not set to
remove data as old as the data you are restoring).

Restoring Data
You can restore data in an active Lookout database with the CitadelControl
object. All you need to do is use an archive database as the source and the
active database as the target.

Pattern Matching
If you only wanted to archive a single data trace, you could just use the path
for that data for Archive trace matching this pattern (the What data
member). For instance, you could use

"\\computername\processname\Waveform1.Sinewave"

to archive a sine wave being logged from the Waveform1 object in the
server process running on the local computer.

If you wanted to archive all the waveforms being logged from that
Waveform object, you could use the following for Archive trace matching
this pattern (the What data member).

"\\computername\processname\Waveform1.*"
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To archive all data in the database you are archiving from, you could use
the * wildcard. To archive all data from a given process on a specified
computer you could enter:

"\\computername\processname\*"

Notice that the use of the wildcard character in the computer name location
will archive data from any other computer running a process with that name
and logging it to the Citadel database you specified as a source.

"*\processname\*"

The Lookout pattern matching feature uses wildcard characters, character
lists, or character ranges, in any combination, to match strings.
The following table shows the characters allowed in a pattern and what
they match:

Use a group of one or more characters (charlist) enclosed in brackets ([]) to
match any single character in a string. This list can include almost any
character code, including digits.

Note To match the special characters left bracket ([), question mark (?), number sign (#),
and asterisk (*), you enclose them in brackets. The right bracket (]) cannot be used within
a group to match itself, but it can be used outside a group as an individual character.

By using a hyphen (-) to separate the upper and lower bounds of the range,
a charlist can specify a range of characters. For example, [A-Z] results in a
match if the corresponding character position in string contains any
uppercase letters in the range A-Z. Multiple ranges are included within the
brackets without delimiters.

Lookout also uses the following pattern matching rules:

• When used outside brackets, the exclamation point matches itself.

• A hyphen (-) can appear either at the beginning (after an exclamation
point if one is used) or at the end of charlist to match itself. In any other
location, the hyphen is used to identify a range of characters.

Character Matches in String

? Any single character.

* Zero or more characters.

/# Any single digit (0–9).

[charlist] Any single character in charlist.

[!charlist] Any single character not in charlist.
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• When a range of characters is specified, they must appear in ascending
sort order (from lowest to highest). [A-Z] is a valid pattern, but [Z-A]
is not.

• The character sequence [] is considered a zero-length string.

CitadelControl Data Members

Data Member Type Read Write Description

Cancel logical yes yes Stops the archive operation when this
value transitions to TRUE. Data
already archived remains in the
archive. The next time you start
archiving data, the CitadelControl
begins where it stopped when
Cancel went TRUE (assuming you
have not changed the other settings).

Complete numeric yes no Reports the percentage of the archive
operation that has been completed.

DeleteEnabled logical yes yes When true, CitadelControl deletes the
data it is archiving from the source
database.

FromWhen numeric yes yes Sets the beginning time for archiving
data. Set this value using ordinary
Lookout time notation, such as
01/01/00 13:30:00. Setting this value
to 0 archives data all from the
beginning of the database to ToWhen

limit when the CitadelControl Start
data member goes TRUE.

FromWhere text yes yes Path to the source directory for the
database your CitadelControl object
is archiving data from.

Start logical yes yes When this value transitions to TRUE,
CitadelControl begins archiving.

ToWhen numeric yes yes Sets the end time for archiving data.
Set this value using ordinary Lookout
time notation, such as 01/01/00
13:30:00. Setting this value to 0
archives data up to the current time
when the CitadelControl Start data
member goes TRUE.
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Citadel Logging
This section clarifies how Citadel logs continuous data, and details a
change in enforcing data lifespan in Citadel.

How Citadel Logs Continuous Data with a Slow Rate
of Change
If you are logging numeric data with a slow rate of change, the way
Lookout logs the data is important.

If you are polling a data point with a time interval of t, where t is faster than
the change in the data, you might see the following values:

(t1, X); (t2, X); (t3, X); (t4, X); (t5, X); (t6,Y)

What Citadel will actually have logged in this case is the value X at time t1.
Citadel then logs the values at times t2 through t5 temporarily (in case of
system failure). When the change is detected, the value at time t5 is logged
permanently and then the value at time t6 is logged.

Citadel Data Lifespan Enforcement
As mentioned in the documentation for the CitadelControl, data is cleared
from the database according to its lifespan setting more aggressively than
in earlier versions of Lookout. Formerly, Citadel deleted data only at
certain times. Citadel now removes over-age data regularly. If you have
been depending on loose enforcement of data lifespans in your data backup,
you should take the more timely enforcement into consideration.

Using SQL Queries From Microsoft Query in Lookout
The introduction of multiline TextEntry objects in Lookout 4.5 makes it
easier for you to copy an SQL query from Microsoft Query and use it in
Lookout. Microsoft Query breaks lines in the SQL statement by embedding
newline codes into the query. The new Lookout 4.5 multi-line edit box can
handle these embedded newlines where the single-line edit box in earlier
versions of Lookout could not.

ToWhere text yes yes Path to the target database for your
CitadelControl archiving operation.

What text yes yes The Lookout trace name of the data
you want to archive. You can use
wildcards and pattern matching to
archive multiple traces if you want.

Data Member Type Read Write Description
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To cut and paste Microsoft Query generated SQL queries into Lookout, use
the following procedure:

1. Before you create a DataTable or SQLExec object, create a TextEntry
object.

2. Create a DataTable object or SQLExec, set the Connect String or
Data Source to point to your data source and set the SQL Command
to the name of your TextEntry object.

3. Build your query in Microsoft Query. The following illustration shows
a query created in Microsoft Query.

4. Copy the SQL statement.



Lookout 4.5 Release Notes 14 ni.com

5. In Lookout run mode, click on the TextEntry object, click on the »
button to make the edit box multi-line, paste the SQL statement into it,
then click on OK.

Your SQL query will now work for you in Lookout without your having to
insert double quotes to denote special characters.

Mailer Object Parameters
The Mailer object class parameters were not available for listing in
Appendix A, Object Class Parameters, of the Lookout Object Reference
Manual PDF. The following table documents the parameters, listed in
order, for the Lookout Mailer object class.

Parameter Name Type Description

1 Buffer unsent
messages

LogCnst Enter yes to buffer unsent
messages, no to disable buffering

2 Retry Attempts NumCnst Number of times Lookout will
attempt to sent your message; enter
an integer (such as 5)

3 Retry delay NumCnst Time in minutes between each
attempt Lookout makes to send
your message; enter an integer
(such as 15)

4 SMTP server TxtCnst Name of your SMTP server; enter a
string (such as “PO1”)

5 Timeout NumCnst How long in seconds Lookout
waits for your mail to be sent
successfully. Sending mail
successfully involves a number of
operations, so make sure you
choose a long enough time. Enter
an integer (such as 10)

6 Alarm priority NumCnst Alarm level 1–10
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Alarm Filter Options
The Ack User Name and Ack Comment options have been removed from
the Lookout Alarm Filter.

Multi-line Text Changes
In previous versions of Lookout you could not embed line returns in text
strings you entered using a TextEntry object or in a Lookout expression.
The multi-line capability in Lookout 4.5 makes this possible. You must
remember, however, that carriage returns can interfere in certain parsing
operations, so be careful how you use them.

Using Lookout as an OPC Server
Lookout functions as an OPC server, and is compliant with the OPC 2.0
specification. OPC items in Lookout take standard Lookout data names,
including the computer name and process name elements of the path.

Known Issues
The following known issues exist for Lookout 4.5.

Lookout Control Sources and Refresh Value Operations
Under some circumstances, a bug in an early version of Lookout 4.0
resulted in certain unpredictable or incorrect behaviors with respect to
remote source URL connections. Additionally, the circumstances in which
Lookout refreshed a value were not previously documented. This section
describes the corrected behavior in Lookout 4.0.1 and greater.

Lookout has two basic connections: URL connections for remote source of
a control, and direct connections, made with the Edit Connections dialog
box for local source controls.

A Lookout control using a remote source URL connection to a PLC or
object takes its value from that PLC or object, so you can think of the PLC

7 Generate event on
successful send

LogCnst To report that your messages was
sent successfully, set to yes;
otherwise set to no

8 Word wrap message LogCnst To wrap your message at
70 characters, set to yes; otherwise
set to no

Parameter Name Type Description
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or object as "owning" the value. If the PLC or object changes, the control
with the remote source connection changes to reflect the new value or
status. When the remote connection is made to field hardware, Lookout
refreshes the control's value when the driver polls the hardware.

If you operate a Lookout control with a remote source connection, and the
PLC register it is connected to cannot or does not change when Lookout
writes the new value out to the PLC, the control changes back to display the
actual PLC register value or status. (The time this takes depends on data
transmission time between your Lookout computer and the field hardware.
See the discussion of the snapDelay data member for the Switch object in
the Lookout Help or the Lookout Object Reference Manual PDF file for
further information.)

A Lookout control with a local source and a direct connection (made
through the Edit Connections dialog box) “owns” the value held by the
control. The control value will not change if something acts to alter the
value or status of the PLC or object it is connected to, and Lookout will
restore the control's value to the PLC or object in the following
circumstances:

• When the driver object is modified

• When the process is reloaded

• After communication is restored after a communications failure

• After 100 polls in some cases (this varies from driver to driver and may
depend on INI settings)

• Any time I/O reconfigures (meaning any time you add or remove a
read or a write to a driver)

Notice that these rules apply to Lookout client and server connections.
Clients should use remote source URL connections to objects in a Lookout
server, so that the server process will "own" the values, at least relative to
the client (even though the server process may itself use a remote source
URL connection to field hardware).

The bug fix for this problem involves both Lookout and the individual
driver object CBX files. While Lookout and the most frequently used driver
object classes have been fixed, the following drivers still need this fix
incorporated.

AdvantechPCL ASCII Cutler-Hammer

DeltaTau Dynamic FisherROC

Hitachi IPASCII Philips

Phoneducer ProfibusDP ProfibusL2
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There are two Lookout drivers which cannot support remote source
connections because the underlying protocols themselves do not allow this
sort of connection. These are the Aquatrol and the DeviceNet drivers.
The DeviceNet Explicit Messaging driver does, however, support remote
source connections, and the current DeviceNet Explicit Messaging driver
does work properly with this type connection.

Check the Lookout download site at

ftp://ftp.ni.com/support/lookout/Lookout4fixes/

for new versions of these CBXs, which will be posted as soon the fix is
implemented in each.

Security File Compatibility
Lookout security files are backward but not forward compatible. In other
words, if you edit or import a lookout.sec or a Lookout .lka file from
an earlier version of Lookout with Lookout 4.5 it will work properly. You
will not be able to use any converted files with the earlier versions of
Lookout, however.

Connection Browser Open with No Processes Visible
Occasionally the Connection Browser may open with no processes visible
in the window. Close the Connection Browser and then reopen it. This will
usually clear the problem. If for some reason it does not, close the
Connection Browser again and make sure you select a process in your
Object Explorer before reopening the Connection Browser.

Exporting a Web Client
You can only export a web client process that is in the Lookout directory;
the .l4p, .lks, and .l4t files must be in your Lookout directory when
you export the client.

RKC F series Reliance S53964

Sixnet Wizdom

Special Cases: Aquatrol DeviceNet
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Roadmap for Experienced Users of Lookout
This section tells where you can find more detailed information on the new
features and functionality of Lookout 4.5.

You can find information on using the new Lookout objects in the Lookout
Object Reference Manual, distributed as a PDF file installed in the
Documentation folder of your Lookout directory during installation
(ObjectRef.pdf), and also in the Lookout Windows Help system. Look
there for information on the Aggregate, ActiveX, Report, DataSocket,
Mouse, and Joystick object classes. You will also find information on the
new drivers in these locations as well.

Lookout installs ten ActiveX controls from National Instruments
ComponentWorks. Learn more about these controls through their own
online help, which you can access through each control’s property pages.

Detailed information on the new Image Navigator graphics is available in
the Image Navigator section of Chapter 2, Graphics, of the Lookout
Developer’s Manual, as well as in the Image Navigator online help.

Using the convenient new list server and auto-detection features for
registering computers is described in the List Servers and Auto-Detection
section of Chapter 4, Networking, of the Lookout Developer’s Manual, and
in the Lookout online help. Access this new set of capabilities by selecting
Options»Network in Lookout.

The usability enhancements for Lookout may best be explored by using
them. Right-click on objects in the Object Explorer and you will find that
you can now cut, copy, and paste objects. You can also open both the Edit
Connections and Edit Database box by right-clicking on an object or even
on a data member in the Object Explorer, and find the box opening to your
selected object or data member. For a more formal explanation of these
enhancements, consult the Object Explorer section of Chapter 3, Lookout
Basics: Windows, Tools, and Files in the Getting Started With Lookout
manual.

In the Connection Browser you will notice that you can now see the data
values being passed between Lookout connections. For more information
on the Connection Browser, see the Connection Browser section of
Chapter 3, Lookout Basics: Windows, Tools, and Files in the Getting
Started With Lookout manual.

Notice that the Lookout User Manager has been renamed the National
Instruments User Manager. This is because the permissions based network
security of Lookout is being integrated with other National Instruments
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products, such as the LabVIEW Datalogging and Supervisory Control
module. The User Manager functions the same way it did in Lookout 4.0.

Object class parameters are now documented in order of their appearance
in the Connection Browser and a Lookout .lks file. This documentation is
necessary for using the Aggregate Object introduced in Lookout 4.5. You
can find this documentation in Appendix A, Object Class Parameters, of
the Lookout Object Reference Manual, which is installed as a PDF file in
your Lookout Documentation directory.

Compatibility and Conversion with Lookout 4.5
To open Lookout 4.0 processes in Lookout 4.5, open the .lks file instead
of the .l4p file when you load a process. As soon as the process opens,
save it to update the .l4p file.

If you are upgrading from Lookout version 3.8, you should be able to open
all your processes in Lookout 4.5 with little or no difficulty. Some minor
adjustments may have to be made in some processes, and you will have
to change redundancy using backup computers. This section covers
compatibility and conversion issues for those upgrading form version 3.8
of Lookout.

Lookout 3.8 and Lookout 4.5 Compatibility
The following list contains known compatibility issues and fixes for
Lookout 4.5:

• Lookout 4.5 does not run on Windows NT version 3.51 or earlier—you
must be using Windows NT 4.0 or later.

• Earlier versions of Lookout process files used the file extension .lkp,
and state files used the extension .lst. Lookout now uses the .l4p
extension for process files and .l4t for state files.

If you want to run your old 3.8 processes on a 3.8 version, save backups
of the files. Otherwise, recompiling a 3.8 process in Lookout 4 or
greater will create (if you save) new .lks, .l4p, and .l4t files.
Lookout also creates new security files using the extension .lka.

• Avoid installing Lookout 4.5 over Lookout 3.x.xx. Either uninstall your
previous version of Lookout, or put Lookout 4.5 in a new directory,
transferring or copying files for conversion.

• Lookout 3.x.xx can run on the same computer with Lookout 4.5, and a
process in one can be networked to a process in the other using DDE.
If you intend to run both versions at one time, start the earlier version
of Lookout first.
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• Lookout 3.8 Citadel files cannot be used by Lookout 4.5. You should
maintain old Citadel files separately from Lookout 4.5 database files.

• Events are now stored with alarms and process data in the Citadel
database.

• The default location for data logged with the Spreadsheet object is the
Lookout directory. The Lookout directory is also the default for any
spreadsheet files you might export from the DataTable object or .csv
(comma separated value) files you might create with the Print Alarms
dialog box. If you do not want these files to be created in the Lookout
directory, enter a complete path (including file name) for the location
where you want the file created.

Converting Lookout 3.8 Processes to Lookout 4.5
To load a Lookout 3.8 process file in Lookout 4.5, select File»Open and
set the Files of type to Lookout Source Files (*.lks).

Select the file you want to convert and click on the Open button
(or double-click on the file name). Lookout uses the built-in CBL
compiler to recompile the 3.8 source file into a Lookout 4.5 process file.

Converting 3.8 files may require the following adjustments:

• Lookout 3.8 versions of the Pot, Switch, Pushbutton, and TextEntry
objects that are remoted convert as L3Pot, L3Switch, and so on, and
continue to function as they formerly did. You cannot create new 3.8
objects like these through Lookout 4.5.

Because remote position source connections have changed in response
to the demands of networking, you may find you want to replace L3
versions of these controls with the new Lookout 4.5 versions,
especially if you want these controls to operate over a network. Delete
the old controls and replace them with new controls using the same
names. The Connection Browser and Object Explorer can help you
track all the connections that may need to be re-established if you
decide to make these replacements.
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• ODBC/SQL limitations: With the introduction of networking and
hierarchical arrangement of objects within processes, it is easy to
exceed the 62 character limit that exists in Microsoft Access and
Microsoft Query. Even fully-compliant ODBC programs are limited
to 126 characters, so some consideration of these limitations when
assigning computer, process, and object names is necessary, if you
intend to use SQL queries.

• The old LKSwap CBX no longer works. If you used this special object
class from the old Lookout Evaluation Guide, you will have to replace
it with the Lookout Loader object, which is more flexible and powerful
than the old LKSwap object. Remember too that Lookout 4.5 can run
multiple processes, so it is not necessary to shut one process down
before running another.

• Fonts are preserved when converting Lookout 3.8 process files to 4.5
using the .lks file, but font code page information is lost. This
appears to mostly affect international users whose languages use a
different code page than the US code page.

• The $Alarm object syntax in an .lks file has changed. The full URL
for a $Alarm object will be as follows:

\\machine\process\$Alarm

• Your custom built Lookout 3.8 CBXs should run in Lookout 4.5, as
long as they were developed using the Lookout Object Developer
Toolkit. If you have problems with a custom CBX, contact National
Instruments technical support for help in resolving the problem.

• The Lookout HyperTrend object now accesses data through a URL
connection. The data source for that connection must be logged to the
Citadel database for the HyperTrend to display the data.

• When you convert a process with a Lookout 3.xx HyperTrend in it,
Lookout automatically creates a named expression to make the URL
connection to. Lookout automatically logs this named expression to
the Citadel database. To maintain your converted HyperTrend objects,
you must use or replace these named expressions.

• If you have Lookout 3.8 processes that use the NIDAQ or NISCXI
objects, and you have a version 6.5.1 or earlier of NI-DAQ installed on
your computer, you must upgrade to NI-DAQ 6.5.2 or better to use
Lookout 4.5. You can download the current version of NI-DAQ
software from the National Instruments web site, at ni.com.

If your Lookout process will be running on the same computer as your
National Instruments Data Acquisition or SCXI hardware, we
recommend that you edit your process to use the OPCClient object to
connect to NI-DAQ, for performance reasons.
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Importing Old Security Files into Lookout
You can import the user account information from your Lookout 3.8
processes into Lookout 4.5 using the National Instruments User Manager.
(Importing is not necessary if you are upgrading from Lookout 4.0 to
Lookout 4.5; Lookout converts the file automatically when you open it with
the User Manager.)

1. Select Options»User Manager from the Lookout menu. You must be
in edit mode for the User Manager item to appear in the Options menu.
The User Manager dialog box appears.

2. Select User»Import Security File from the User Manager dialog
box. The following dialog box appears.

3. Navigate to your old Lookout 3.8 security file Lookout.sec, and
select it. Lookout 3.8 kept the Lookout.sec security file in the
Lookout directory.

4. Click on the Open button.
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5. If you have already created any user accounts in Lookout 4.5 that are
the same as accounts you used in Lookout 3.8, you will receive a
message informing you that a user account with that name already
exists. You may replace your recently created account, or choose not
to use the old account information.

6. Exit the User Manager.

Note Unlike Lookout 3.8, Lookout 4.5 maintains the Lookout.sec security file in the
Windows System directory.

The User Manager creates a unique identification number for each user account. This
means that to maintain identical accounts, you must use the same Lookout.sec file for
each copy of Lookout running on your network. Copy your Lookout.sec file to the
Windows System directory in every computer you intend to run Lookout on.


	Lookout 4.5 Release Notes
	Contents
	Requirements
	Installation
	Registration

	Corrections and Additions to the Documentation
	CitadelControl
	Archiving Data
	Restoring Data
	Pattern Matching
	CitadelControl Data Members

	Citadel Logging
	How Citadel Logs Continuous Data with a Slow Rate of Change
	Citadel Data Lifespan Enforcement

	Using SQL Queries From Microsoft Query in Lookout
	Mailer Object Parameters
	Alarm Filter Options
	Multi-line Text Changes
	Using Lookout as an OPC Server

	Known Issues
	Lookout Control Sources and Refresh Value Operations
	Security File Compatibility
	Connection Browser Open with No Processes Visible
	Exporting a Web Client

	Roadmap for Experienced Users of Lookout
	Compatibility and Conversion with Lookout 4.5
	Lookout 3.8 and Lookout 4.5 Compatibility
	Converting Lookout 3.8 Processes to Lookout 4.5
	Importing Old Security Files into Lookout


